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1-АМАЛИЁТ. Медиамонтаж тамойиллари 
Фан бўйича амалий машҳулотларга қўйиладиган 
талаблар. Компьютерда медиамонтаж қилиш 
тамойиллари билан танишиш. Медиатаҳрирловчини 
ўрнатиш ва созлаш. Лойиҳа файлларини 
алмаштириш.  

АМАЛИЙ МАШҒУЛОТЛАРГА ҚЎЙИЛАДИГАН ТАЛАБЛАР 
Амалий машғулотлар махсуслаштирилган компьютер синфларида ҳар 

битта талаба томонидан ўқитувчи раҳбарлигида ушбу услубий кўрсатмаларга 
биноан амалга оширилади. Амалий машғулотнинг ҳар битта пункти талаба 
томонидан ўзлаштирилиши лозим.  

Талаба амалий машғулотлар учун мавжуд бўлиши зарурий бўлган 
қуйидаги индивидуал воситалардан фойдаланиши лозим: 

• 40-16000 Гц диапазонида ўрта миёна чизиқли қайта эшиттириш учун 
етарли бўлган ва сифатли қайта эшитиришни амалга оширадиган 
наушниклар; 

• Хотираси камида 4 Гб, имкони борича 400 Гб дан ортиқ бўлган флеш-
сақлагичлар ёки бошқа ахборот ташувчилари. 

Амалга ошираётган ҳатти-ҳаракатларни тўла тушуниб етиш ва аудио-
видеомонтаж мақсадларида компьютер технологияларидан фойдаланиш 
пайтида абсолют ойдинликка эришиш учун маъруза матнларидан, 
дасрликлар ва ўқув қўлланмаларидан фойдаланиш лозим.  

Талабалар мустақил равишда қоғозга ёки файлга амалий ишларни 
бажариш пунктларининг зарурий қисмларини ёзиб борадилар.  

МЕДИАТАҲРИРЛОВЧИ ИНТЕРФЕЙСИ 
Дастурнинг пастки қисмида Time line ёки монтаж тасмаси жойлашган 

бўлиб, унда видео ва аудио монтаж бевосита амалга оширилади.  
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Биз нима иш бажараётганимизни кўриш учун олдиндан кўриш ойнаси 

мавжуд.  
 
 
 
 
 
 
 
 

 

 
 

Дастурнинг чап қисмида турли хил кўп сонли вкладкалар мавжуд. 
Уларнингбиринчиси Explorer-йўл бошловчи бўлиб, у Windows йўл 
бошловчининг ўрнини босади. Кейинги вкладка Project Media. Бу вкладкада 
ушбу лойиҳада мавжуд бўлган барча файллар акс этади. Кейинги вкладка 
Transitions ёки ўтишлар вкладкаси. Улар битта тасвирдан иккинчи тасвирга 
ўтиб кетиш учун қўлланилади. Бунинг учун ўтишлардан бирортасини танлаб 
олинг ва уни Time line га ўтказинг. Кейинги вкладка Video FX бўлиб, унда 
видео эффектлар мужассам бўлади. Амал қилиш тамойили худди Transitions 
вкладкасига ўхшайди. Кейинги вкладка Media Generators Transitions ва Video 
FX каби иш қилади. Сўнгги вкладка Trimmer видеодан ёки лойиҳадан 
алоҳида лавҳаларни кесиб олиш учун қўлланилади.  
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Ўзингизнинг созлашларингизни сақлаб қолиш учун View-Window 
Layouts-Save Layout as ни бажариш керак. Очилган ойнада ихтиёрий ном 
киритамиз, агар сиз иш жараёнида ойналарни сурган бўлсангиз ва 
кейинчалик ҳаммасини жой-жойига қўймоқчи бўлсангиз View-Window 
Layouts-га кириб созлашнинг номини киритишингиз зарур бўлади.  

ФАЙЛЛАР ИМПОРТИ ВА ЛОЙИҲАНИ ТАШКИЛ ЭТИШ 
Sony Vegas да файлларни импорт қилиш учун Project Media вкладкасига 

кириб тугмачани босиш керак. Ойна пайдо бўлади ва унда сиз лойиҳа учун 
файл танлаб 

олишингиз 
мумкин бўлади.  

Шунингдек 
йўл 

бошловчидан 
фойдаланиш 

мумкин. 
Керакли файлни 
белгилаб олиб 
уни Project 
Media га 
кўчириб олиб 
ўтиш лозим.  

Файллар 
импортининг қулайлиги учун Explorer вкладкасида уларни дастурга 
юклашдан олдин файлларни олдиндан кўриш мумкин бўлади. Бунинг учун 
файлни танлаб оласиз ва Start Preview тугмасини босасиз.  

ЛОЙИҲА ФАЙЛЛАРИНИ САҚЛАШ 
Лойиҳани сақлаш учун File-Save as га кириб, лойиҳанинг номини 

киритиш лозим. Sony Vegas дастури файлларнинг барча жойлашиш 
манзилларини сақлаб туради ва агар сиз файлингиз жойлашган папкани 
ўзгартирсангиз ёки ўчирсангиз лойиҳани очаётган пайтда ойна пайдо бўлади 
ва унда файл етишмаётганлиги кўрсатилган бўлади. Бундай бўлмаслиги учун 
барча файлларни битта папкада сақланг, ўшанда бор-йўғи папканинг янги 
жойини кўрсатиш керак бўлади.  

Лойиҳани ташкил этишда сиз турли жойларда турган файлларни 
ишлатасиз. Sony Vegas дастури файлларнинг барча жойлашиш манзилларини 
сақлаб туради ва агар сиз файлингиз жойлашган папкани ўзгартирсангиз ёки 
ўчирсангиз лойиҳани очаётган пайтда ойна пайдо бўлади ва унда файл 
етишмаётганлиги кўрсатилган бўлади. Лойиҳани қулай ва тўғри ташкил этиш 
учун Sony Vegas дастурида лойиҳани сақлаб қолиш учун жуда қулай 
функция кўзда тутилган. File-Save as.. менюсига кирамиз, натижада бизга 
лойиҳани сақлаб қолишни таклиф этадиган ойна пайдо бўлади.  
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Лойиҳани D дискида янги папкада сақлаймиз ва айни пайтда сиз 
қўллаётган файлларни нусха қилиб кўчириш учун Copy media with project 
тўғрисига белги қўйиш керак бўлади. Ундан кейин сақлаб қолинади. Шундай 
йўл билан сиз барча файлларингиз ва лойиҳангиз жойлашадиган папкани 
яратган бўласиз.  

ҚЎШИШ ВА БОШҚАРИШ 
Sony Vegas да янги лойиҳа очамиз ва унга бир нечта видео ҳамда аудио 

файлларни қўшамиз. Файлларни Project media дан Time linе га кўчириб 
ўтказиш учун шунчаки файлни белгилаб олиб, Enter ни босиш керак бўлади. 
Бундай видео йўлакчалар жуда кўп бўлиши мумкин. Сиз уларни ихтиёрий 
жойда жойлаштиришингиз, шунингдек матн қўшишингиз мумкин. Бунинг 
учун Insert-вкладкасига кириб янги йўлакни танлаймиз, Media Generators ни 
танлаймиз ва матн қўшамиз. Агар сиз матнли йўлакни чўзсангиз, мос 
равишда унинг роликдаги давомийлиги ҳам ошади.  
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Агар сиз роликларингизни бир-бирини остига жойлаштирсангиз, энг 

тепада турган ролик қолганлирини тўсиб қўяди ва улар кўринмай қолади.  
 

  
Шунингдек барча видео лавҳаларни битта йўлакка кўчириб тушириш 

мумкин, бу ҳолда иккита кадр бир-бири кесишган тақдирда улар силлиқ 
равишда биридан иккинчисига ўтиб кетади.  
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Янги видео трек яратиш учун Ctrl+Shift+Q клавишаларини босинг,  

керак бўлмаган трекни ўчириш учун уни белгилаб олинг ва Delete 
клавишасини босинг. Видео йўлакларни кўчириб ўтказиш учун уларни 
белгилаб олиш зарур, кейин сичқончанинг чап кпонкасини босиб уларнинг 
ўрнини алмаштирасиз. Шунингдек сиз видеонинг керак бўлмаган 
лавҳаларини ўчириб ташлашингиз мумкин, бунинг учун курсорни керакли 
жойга ўрнатиб S (кесиб олиш) клавишасини босинг ва керак бўлмаган 
қисмини ўчириб ташланг.  

Сиз шунингдек аудио йўлакни Time linе га кўчириб олиб уни лойиҳага 
қўшишингиз мумкин.  
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Видео треклардан фарқ қилиб, аудио йўлаклар бир-бирини кесиб 

ўтмайди,чунки улар бир пайтда эшиттирилади.  
Видео трекларда улар билан ишлайдиган тугмачалар мавжуд бўлади. 

Масалан, Mute тугмаси ушбу видео трекни кўриб чиқаётган пайтда ўчириб 
қўяди, Solo тугмаси эса трекни ҳаттоки у энг пастда бўлган пайтда ҳам 
кўриш имконини беради ва бунда қолганлари ўчган ҳолатда бўлади.  
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2-АМАЛИЁТ             Эффектлар 
Эффектлар-асосий тамойиллар. Титрлар. Шаффоф 
фондаги матн. Слайд-шоу – яратиш тамойиллари. 
Битта гуруҳга бирлаштириш, альфа-канал 

ЭФФЕКТЛАР АСОСИЙ ТАМОЙИЛЛАР 
Барча махсус эффектлар қатори Video Fx, вкладкасида жойлашган 

бўлади, мисол учун  оқ-қора тасвир берадиган, равшанлик ва имитация 
рангини тартибга солиш, суркалиб кетиш ва ҳоказо.  

Ана шу дарс учун тайёрланган файлни импорт қиламиз.  
Эффектлар жойлашган вкладкага ўтиб, Border ни танлаймиз. Bevell 

эффектини танлаймиз ва уни файлга кўчириб ўтказамиз.  
 

 
 
Кўпинча битта эффект етишмайди, шунинг учун яна биттасини худди 

шу йўл билан қўшамиз.  
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 Эффектларга белги қўйиб ва олиб ташлаб уларни ўчириш ва қайта ёқиш 

мумкин.  

PEN CROP ИНСТРУМЕНТИ 
Файлларни импорт қиламиз ва уларнинг биттасини Time Line га кўчириб 

ўтказамиз.  
 

 
 
Лойиҳани созлаймиз, бунинг учун Alt+Enter ни босамиз ва ундан кейин 

Field older→None  созлашини амалга оширамиз.  
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Файл охирида Pen Crop  тасвири бор бўлиб, ўшани босамиз. 
 

 
 
Pen Crop менюсини ўрганиб чиқамиз, файлни қандай қилиб масштаб 

қилишни ва ихтиёрий даражага айлантиришни ўрганамиз.  
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Инструментлар панелини ўрганамиз. 
 

 
ФОТОСУРАТЛАРДАН СЛАЙД ШОУ ЯРАТИШ  

Файлларни импорт қиламиз ва уларни Time linе га кўчириб ўтказамиз.  
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Бунда ҳар битта кадрни анимация қилиш мумкин. 
 

 
 
Аудио файлни қўшамиз. 
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Аудио файлни видео файлга мос келадиган даражагача қисқартирамиз.  
 

 
 
Render As тугмасини босамиз ва Divx форматида сақлаймиз. 



АУДИО- ва видеомонтаж   

     17 

 
 

Слайд-шоу да анимацияларни яратиш 
Файлни импорт қиламиз ва уни Time linе кўчириб ўтказамиз, Pen Crop 

ни босамиз. 
 

 
 
Қора йўл-йўл чизиқлардан қутуламиз. Бунинг учун ўнг клавишани 

босамиз ва Match output Aspect ни танлаб оламиз. 
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Вақт шкаласида курсорни ихтиёрий жойга кўчириб ўтказамиз ва тасвири 

бор экранда ўзгартиришларни амалга оширамиз. Натижада асосий кадр 
пайдо бўлади.  

 

 
 
Буни бир неча марта амалга оширамиз ва бир нечта асосий кадрни 

яратамиз.  
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Матн ҳам қўшишимиз мумкин бўлади. 
 

 
 

Стандарт ўтишлар 
project media вкладкасини танлаймиз, мисоллар жойлашган папкадан 

тайёр фотосуратларни импорт қиламиз.  
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Сўнгра Еnter ни босамиз, барча фотосуратлар time line га кўчиб ўтади.  

Энди битта кадрни иккинчисининг устига ташлаймиз. 
  

 
 
Энди Transitions/ вкладкасига ўтамиз. Биринчи эффектни (Simple) 

танлаймиз ва уни ўтиш жойига кўчириб оламиз.  
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Ойнани ёпамиз. Худди шу йўл билан қолган қисмларга ишлов берамиз, 

шунчаки ўтиш жойини “крестик”ка кўчириб ўтказиб оламиз. Энди ўша 
папканинг ўзидан мусиқани импорт қиламиз. 

 

 

 

DivX да Рендер туридаги ўтишларни аниқлик билан созлаш 
Ўтишни танлаб оламиз ва кесишиш жойини босамиз.  
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Бу ердаги созлашларни ҳаттоки ички ҳис билан тўғрилаш мумкин. 

Параметрларни ўзгартириб, шунингдек агар сизга созлашлар маъқул бўлса, 
сиз уларни прсетни босиб сақлабқўйишингиз мумкин.  

Энди бизнинг биринчи ўтишимиз қандай тузилганлигини кўрамиз 
(Blinds). Эффектни 2 сонияга кўпайтирамиз ва унинг хусусиятларини кўриб 
чиқамиз.  

 

 
 
Бошида сичқонча ёрдамида “қоронғиликдан пайдо бўлиш”ни қўшамиз. 

Энди тайёр клипни рендер қилиш мумкин. Бунинг учун видеонинг барча 
лавҳалари тагини белгилаб олиш мақсадида 2 мартадан босамиз ва рендеринг 
менюсига кириб, кераклисини танлаб оламиз  
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БИТТА ГУРУҲГА БИРЛАШТИРИШ 
Объектларни битта гуруҳга бирлаштириш зарурий жараён бўлиб, 

монтажда кўпинча қўлланилади ва лойиҳа қанчалик катта бўлса, унга 
шунчалик кўп мурожаат қилинади.  

1. Бир нечта видеофайлларни очамиз. 
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Бир нечта файлларни Time line га кўчирамиз. Биз кўчириб ўтказган 

видео ўзида аудио йўлакларни ўзида сақлаган бўладива у видео билан бирга 
ҳаракатланади, уни ажратиб олиш учун видео ёки аудио оқимнинг устида 
сичқончанинг ўнг тугмасини босиш керак. Натижада контекст меню пайдо 
бўлади ва унда Group – Remove From танлаш ёки клавиатурадаги (U)  
клавишани босиш керак бўлади. Овоз йўлагини олиб ташлаймиз.  

 

 
 
Бир нечта видео йўлакларини қўшамиз ва уларга бизнинг видеони 

кўчириб олиб ўтамиз.  
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Баъзида шундай бўладики, бирин-кетин турган видео лавҳаларни битта 

блокка бирлаштириш ва уни Time line бўйлаб суриш лозим бўлади. Буни 
Auto Ripple тугмаси орқали амалга ошириш мумкин бўлади, бироқ унда 
танлаб олинган лавҳанинг орқасида турган лавҳалар ҳам сурилиб кетади. 
Агар бизга барча эмас, балки бир нечта лавҳаларни гуруҳга бирлаштириш 
керак бўлса, SHIFT клавишасини босиб керакли лавҳаларни белгилаб оламиз. 
Сичқончанинг ўнг тугмасини босиб Group – Greate New ни танлаб оламиз ва 
(G) клавишасини босамиз. 

 

 
 
Агар гуруҳдан бирорта лавҳани олиб ташлаш керак бўлса, сичқончанинг 

ўнг тугмасини босамиз ва Group – Remove From ни танлаб оламиз ёки 
клавиатурада (U) клавишасини босамиз, шундан кейин уни олиб ташлаш 
мумкин бўалди, бироқ бу ҳолда қолган лавҳалар орасидаги бирлашиш 
сақланиб қолади.  

Агар бизга барча лавҳаларни қайта гуруҳдан чиқариш лозим бўлса, унда 
гуруҳнинг ихтиёрий жойида сичқончанинг ўнг тугмасини босамиз ва Group –
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Clearни танлаймиз ёки CTRL+U ни босамиз. Бу ҳолда гуруҳ бутунлай барҳам 
топади ва лавҳалар алоҳида ҳаракатлана бошлайди.  

 

 
 
Агар сизда тайёр лавҳа бўлса ва сиз уни тўсатдан бузиб қўйишни 

истамасангиз, сиз уни ёпиб қўйишингиз мумкин. Бунинг учун «выделение» 
инструменти ёрдамида объектни ёки объектлар гуруҳини танлаб оламизунда 
сичқончанинг ўнг тугмасини босамиз ва Switches ни танлаймиз, Lock ни 
олдига “қушча” (“птичка”) белгисини қўямиз. Энди бу элементлар ёпилган 
бўлади ва биз уларга ҳеч қандай таъсир қила олмаймиз.  
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Агар сиз ёпиқ гуруҳнинг битта элементини ўзгартирмоқчи бўлсангиз, 

унинг устида сичқончанинг ўнг тугмасини босиб, Switches ни танлаймиз ва 
Lock қаршисидаги “қушчани” олиб ташлаймиз. Агар сиз бутун ёпиқ гуруҳни 
очмоқчи бўлсангиз, унда «выделение» инструментини оламиз, гуруҳга 
бирлашган файлларни белгилаб оламиз, сичқончанинг ўнг тугмасини 
босамиз, Switches ни танлаймиз ва Lock қаршисидаги “қушча”ни олиб 
ташлаймиз. 

Сиз шунингдек файлни Time line даги вақт шкаласи бўйича чўзаётган 
пайтда бошқа файл билан тўқнаштириб юборишингиз мумкин. Бундай 
ҳолатга йўлиқмаслик учун унинг устида сичқончанинг ўнг тугмасини босиб, 
Properties…(свойства) га кириш керак ва Loop қаршисидаги “қушча”ни олиб 
ташлаш керак Loop (повторение) – ОК. 



АУДИО- ва видеомонтаж   

     28 

 
 
Энди бу лавҳани Time line бўйича чўзганда, сўнгги кадр такрорланади. 

Барча созлашларни эски ҳолатига қайтариш учун ҳам унинг устида 
сичқончанинг ўнг тугмасини босиб, Properties…(свойства) га кириш керак ва 
Loop қаршисига “қушча”ни қўямиз Loop (повторение) – ОК. 

АЛЬФА КАНАЛЛИ ВИДЕО  
Альфа канал-бу шаффофликни билдиради. 
Дастурга фотосуратни ва унинг рамкасини импорт қиламиз.  
 

  
 
Фотосуратни Time line га туширамиз ва унинг давомийлигини 10 сония 

қилиб ўрнатамиз. Шунингдек Time line га рамкани кўчириб ўтамиз (ичидаги 
шаффоф фон билан), дастур шу заҳоти шаффофликни таниб олади.  
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Видео билан ишлаганда сиз шунингдек альфа канал билан ишлашингиз 

мумкин бўлади, бироқ у ҳолда ушбу лавҳада шаффофлик борлигини 
кўрсатиш керак. Бунинг учун сичқончанинг ўнг тугмасини босиб, 
Properties…(свойства) га кирамиз ва Alfa Chanel хоссаларида Straight – OK ни 
танлаймиз. 

 

   
 
Шунингдек дастур билан ишлаганда сиз Секвенцияга дуч келишингиз 

мумкин. Секвенция – бу статик кадрларнинг худди плёнкадагидек кетма-
кетлигидир. Ушбу файлни импорт қилаётганда алоҳида расмларни эмас, 
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балки видео файлни импорт қилиш учун биринчи кадрни белгилаб олиб, 
Open still image sequence қаршисига “қушча” белгисини қўйиш керак бўлади. 

 

   
 
 «Открыть» ни босамиз, натижада созлашларни акс эттирган ойна пайдо 

бўлади. У ерда ҳаммаси тўғри кўрсатилганлигига ишонч ҳосил қилинг ва ОК 
ни босинг. 

 

 
 
 



АУДИО- ва видеомонтаж   

     31 

РАНГНИ КОРРЕКЦИЯ ҚИЛИШ 
Файлни импорт қиламиз, Time Line га туширамиз ва овоз йўлагидан 

халос бўламиз. 
 

 
 
Video FX га кириб иккита эффектни танлаймиз. 
Color Corrector 
 

 
 

Threshold 
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Видеофайлни ана шу эффектлар билан бирга созлаймиз. 
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3-АМАЛИЁТ. VirtualDub билан ишлаш. 
Тезлик билан видеотаҳрирлашни бажариш бўйича лаборатория ишини 

бажариш жараёнида сиз VirtualDUB оиласига кирувчи дастурлар билан 
танишдингиз. Энди уларнинг айрим қўшимча имкониятларини кўриб 
чиқамиз.  

Клипни йўқотишларсиз кесиш  
Юқорида айтиб ўтилганидек, VirtualDub видеофайлларни қайта 

компрессиясиз таҳрирлаш имкониятини беради. Шу туфайли дастурда мисол 
учун концерт ёзувидан муайян лавҳани кесиб олиш мумкин бўлади. Бундай 
операцияни амалга ошириш учун дастлабки файлни очинг ва сурилувчи 
тугмани дискда алоҳида файл кўринишида сақлаш лозим бўлган лавҳанинг 
бошланишига мос келган ҳолатга ўрнатинг. Ана шу клипнинг бошланишини 
белгиланг, бунинг учун <Home> клавишасини босинг ёки дастурнинг Edit 
менюсида Set selection start ни танлаб олинг. Энди сурилувчи тугмани кесиб 
олинаётган лавҳанинг охирига бориб ўрнатинг  ва <End>  клавишасини 
босинг ёки дастурнинг Edit менюсида Set selection End ни танланг. Вақт 
шкаласида белгилаб олинган вақт оралиғи алоҳида ранг билан ажралиб 
қолади.  

 

Қайта компрессияга йўлиқмаслик учун Video менюсида Direct stream 
copy ни танланг ва худди шу пунктни Audio менюсида танланг. Энди файлни 
File > Save as AVI буйруғи ёрдамида сақлаш мумкин бўлади. Модомики . 
қайта сиқиш талаб этилмаётган экан, видеонинг алоҳида лавҳасини сақлаб 
қолиш жараёни жуда кам вақт олади ва деярли файлни дискка ёзишдан 
иборат бўлади.  
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Бир нечта клипни биттага бирлаштириш  
VirtualDub билан ишлаганда сезиладиган асосий ноқулайлик кўп 

йўлакли интерфейснинг йўқлигидир. Биринчи қарашда ҳатто дастур 
фақатгина битта клип билан ишлайди деган таассурот туғилади. Аслида 
VirtualDub чекланмаган лавҳаларни биттага бирлаштириш каби “ямаш” 
операциясини бажариш каби фойдали ишни бажара олади.  

Ямаш иккита йўл билан амалга оширилади – алоҳида ва пакет йўл 
билан. Икки ва ундан ортиқ файлларни қайта компрессиясиз бирлаштириш 
фақатгина улар бир хил параметрларга эга бўлгандагина амалга ошрилади. 
Битта лавҳани очиб бўлинган клипга қўшиш учун дастур менюсида File > 
Append AVI segment ни танлаб олиб, қўшиб олинаётган файлни кўрсатиш 
керак бўлади. Клиплар бирлашиб бўлганига ишонч ҳосил қилишга вақт 
шкаласи имкон беради – видеонинг давомийлиги кўпайган бўлиши керак. 
Видеофайллар гуруҳини бирлаштириш лозим бўлса, уларни муайян: 
video001.avi, video002.avi, video003.avi ва ҳоказо ном билан аташ лозим 
бўлади. Ўшанда алоҳида лавҳалардан бутун видеони яратиш жараёнида 
файллар автоматик равишда ўз тартиб рақами бўйича жойлашади. 
Фойдаланувчи фақатгина биринчи файлни қўшиб қўйиши етарли бўлади. 
Шундан кейин ямаш операцияси худди иккита файл билан ишлагандек 
амалга оширилади.  

VIRTUALDUB ДА ВИДЕОНИ ПАКЕТЛИ ҚАЙТА ИШЛАШ  
VirtualDub таҳрирловчиси содержит так файлларга автоматик ишлов 

бериш имкониятини берадиган вазифалар рўйхатига (Job List) эга. Масалан 
ўнлаб файлларни турли форматларга ўтказиш вазифаси турган бўлсин. Агар 
дастурда пакетли қайта ишлов бериш имконияти бўлмаганида унга навбатма-
навбат видео файлларни юклашга, ҳар сафар янги созлашларни амалга 
оширишга, ҳар сафар файлнинг дискка ёзиб олинишин кутишга, кейин 
навбатдаги видеони очиб, VirtualDub сиқиш жараёнини амалга оширишини 
кутишга тўғри келарди ва ҳоказо. Видеога пакетли қайта ишлов бериш 
туфайли фақатгина қайси операциялар бажарилиши лозимлигини кўрсатиш 
керак бўлади ва кейин компьютерни қаровсиз қолдириб кетса ҳам бўлади. 
Дастур йўриқномаларга қатъий равишда амал қилиб маълумотларга ишлов 
беради. Бирорта вазифани Job List рўйхатига киритиш учун File > Queue 
batch operation амаллар кетма-кетлигини бажариш лозим бўлади. 
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Агар иккита файлни навбатма-навбат сиқиш керак бўлса, қуйидаги 
ишларни амалга оширамиз. Биринчи файлни очамиз, сиқиш параметрларини 
кўрсатамиз, керак бўлса сақлаб қолинаётган клипнинг бошланиши ва охири 
кўрсатилади. Кейин File > Queue batch operation > Save as AVI амаллар кетма-
кетлигини бажарамиз. Шундан кейин дастур ҳеч қандай амаллар бажармайди 
ва биз кейинги файлни очиб экспорт қилишнинг янги параметрларини 
ўрнатамиз ва яна бир марта Queue batch operation меню остисидан керакли 
буйруқни танлаб оламиз. Сўнгра барча вазифалар тузилиб бўлингач, File > 
Job control менюсида Job List рўйхати очилади ва унда пакетли қайта ишлов 
бериш жараёнини бошлаб юбориш учун Start тугмаси босилади. 

РАВШАНЛИК ЁКИ СУРИЛИБ КЕТГАНЛИК  
Лавҳани алоҳида AVI-файлга сақлаймиз  Файл > Открыть видео файл… 

Бизга керак бўлганини танлаб олиб уни юклаймиз. Дастур интерфейсини 
учта асосий бўлакка ажратиш мумкин: асосий, видеони кўриш ойнаси, кўп 
функцияли транспорт панели.  
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Видеони кўриш ойналари иккита бўлиб, чап томондагисида дастлабки 

файл, ўнг томонда эса – қайта ишлов натижаси акс этади.  
Фильтрли ойнани юклаймиз (Видео > Фильтры…), дастлаб у бўш 

бўлади. «Добавить» тугмаси ёрдамида фильтрлар рўйхатига ўтамиз, бизнинг 
амалий мисол учун brightness/contrast (ёриқлик/равшанлик) ва blur (сурилиб 
кетиш) ни танлаб оламиз. Уларни созлаймиз. Фильтрлар ойнасида 
«Изменить…» тугмаси бор. Уни босиб сиз таҳрирловчига ўтасиз, унинг 
доирасида сиз акс эттирмоқчи бўлган кадрнинг муайян қисмини кўрсатасиз.  

ТРАНСПОРТЛИ ПАНЕЛЬ 
Турли стандартларда кадрларнинг турлича тузилмалаштирилиши кўзда 

тутилган. Асосий атамалар билан таниш бўлмаганлар учун эслатиб ўтамиз: 
“кадр” сўзининг рус тилидаги синоними бўлиб “фрейм” ҳисобланади 
(инглизчасига «frame»). 
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ҲАРАКАТЛАНИШ ТУГМАЛАРИ  
Энг яхшиси улардан фойдаланмасдан, “Переход” менюсининг бош 

пункти ичида жойлашган ички операциялардан ёкиуларнинг ўрнини 
босадиган “иссиқ” клавишалардан фойдаланиш керак.  

Қайта кўриш ва эшитиш икки хил бўлади: биз ёки дастлабки видеони 
кўришимиз, ёки дастлабки ҳамда қайта ишловдан ҳосил бўлганини 
кўришимиз мумкин бўлади (бизнинг ҳолда фильтрларни ишлатиб бўлгандан 
кейин).  

Стандарт равишдаги қайта айлантиришдан ташқари бир нечта 
ҳаракатланиш кўзда тутилган: асосий кадрлар бўйича ва саҳналар бўйича. 
Саҳналар бўйича қидирув эвристик бўлади, яъни унинг тўлдирилиши таҳлил 
этилади ва агарда видеоқатор сезиларли даражада алмашган бўлса ана шу 
нуқта топилади. Бундай қидирувнинг сезгирлиги алоҳида созлашларда 
тартибга солинади (Параметры > Параметры настройки > Scene).  

Лавҳаларни ажратиб олиш турли йўллар билан амалга оширилади, 
транспорт панелида махсус иккита тугма бўлиб, уларга ажратиб кўрсатиш 
операцияларининг бошланиши ва охири мос келади.  

Жорий кадрдаги ахборот тўғрисида қатор мавжуд бўлиб, квадрат 
қавсларда бу кадр нимани англатиши кўрсатилган бўлади. Аслини олганда 
AVI ва MPEG-1 даги тақсимлашлар билан таниш бўлган одам учун бу 
қийинчилик туғдирмайди.  

Ягона эътиборли жой — ниқобланган кадрлардир ([M]). Гап шундаки 
дастурда хатоларни таҳлил қилиш мавжуд бўлиб, бирорта фрейм “қилиқ” 
чиқарса, у шунчаки ниқобланади, яъни унинг ўрнига ундан аввалгиси 
кўрсатилади ёки эшиттирилади.  

ВИДЕОНИ ТУТИБ ОЛИШ 
VirtualDub ихтиёрий тўғри келадиган манбадан видеони тутиб олишга 

имкон беради, яъни тюнернинг видеокириш нуқтасидан ёки видеони тутиб 
олиш платасидан. Бу мақсадда Файл менюси очилади ва «Захватить AVI» 
танлаб олинади. Дастурнинг интерфейси автоматик равишда ўзгаради, меню 
пунктлари ҳам ўзгаради. Асосийси – манбани кўрсатиш (Тюнер менюси), 
кодек (Видео > Компрессия ёки «С» клавишаси), формат (ўша ернинг ўзида).  

Баъзи бир параметрлар автоматик равишда кўрсатасиз, шу жумладан 
фильтрларни ҳам улайсиз. Буларнинг барчаси “бир зумда” ишлайди. Худди 
шу йўлда овоз билан мулоқот қиласиз, фақатгина Аудио менюсида овоз 
баландлиги индикатори ёқилганига эътибор беринг. Бу фойдали нарса. 
Сигнал жуда ҳам паст бўлмаслиги лозим, чунки у шовқинлар билан 
биргаликда сурилади, бунда авжига чиқмаслиги ҳам керак – натижада 
тузатиб бўлмайдиган бузилишлар рўй беради.  
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ВИДЕОЛАВҲАЛАР МОНТАЖИ 
Аслини олганда бу ерда монтажнинг имкониятлари кўп эмас, асосан – 

турли лавҳаларни бир-бирига ямаш, яъни қўшиш.  
Энг содда вариант — аввалги мисолдаги файлни олинг, лавҳани 

белгилаб олинг, уни қирқинг (Ctrl+X) ва бошқа ихтиёрий жойга қўйинг.Яъни 
биз иккита кесиб олиш/ямаш операцияларини бажардик. Худди шу йўл билан 
бошқафайлларни қўшиш мумкин, бироқ кўпинча форматларнинг мос келиши 
борасида бир қатор саволлар туғилади. Аслида улар бир-бирига мос келиши 
керак, фақатгина компрессия стандарти бўйича эмас, балки қўшимча 
созлашлари бўйича ҳам.  

Агар кадрларнинг частотаси мос келмаса – қўшилиш амалга ошмай 
қолиши мумкин. Кўпчилик ҳолатларда хато тўғрисидаги ёзув чиқади.   

Айтмоқчи, кадрларнинг “ўзгарувчан” алмашиш частотаси амал қилган 
сиқиш форматлари борасида бир қатор саволлар мавжуд. Яъни сизда 
тузилмаси бўйича бир хил бўлган файллар ёки лавҳалар бўлиши мумкин, 
бироқ биттасини ичига иккинчисини қўя олмайсиз, чунки уларнинг 
частотаси катта бўлмаган миқдорга фарқ қилади. Ана шу муаммодан тезроқ 
қутулиш йўли бўлиб асосий кадрларга қўшиб юбориш ҳисобланади. Яъни у 
ерда частоталар бир хил бўлади. “Ўзгарувчан частотали” вариант кўпинча 
кучли сиқилган фильмларда учрайди.  

Ундан секинроқ таъсир қиладиган усул — файлларни Uncompressed AVI 
га ўтказишдир (агар сиз бошқа кодек ишлатсангиз, сифатини йўқотасиз, 
чунки кўпчилик кодекларда йўқотишли сиқиш амалга оширилади (lossy)). 
Кейин эса истаганингизча ямашингиз мумкин.  

АУДИО ЙЎЛАКЛАР БИЛАН ИШЛАШ 
Аудио билан боғлиқ масалалар жуда қулай бўлмаса ҳам, энг оддий 

даражада ҳал этилган. Қайта ишлаш занжирини йиғишга имкон берадиган 
фильтрлар мавжуд, овоз баландлиги созлагиси бор ва суперфильтрация 
режими ҳам бор.  

Бундан ташқари аудионинг видео билан синхронизация қилиш тизими 
жуда юзаки ҳал қилинган. Энг кўп туғиладиган савол — турли 
видеолавҳаларни бир-бирига қўшиш пайтида юзага келадиган орқада 
қолиш/олдинга ўтиб кетиш ҳолларидир. Бунга бир нечта сабаб бўлиши 
мумкин. Зарурий созлашларни Аудио > Чередование менюсида амалга 
ошириш мумкин бўлади.  
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4-АМАЛИЁT. Маркерлар ва ҳудудлар  
Маркерлар ва ҳудудлар. Триммер, инструментни 
қўллаш. Видеони тезлаштириш ва секинлатиш  

МАРКЕРЛАР 
Маркер – бу лойиҳадаги эсга солиш, закладка каби нарсадир. Ихтиёрий 

файлларни танлаймиз, мен 3 та расм ва битта овозли файл олдим. Ихтиёрий 
шаклда файлларни тайм лайнга жойлаймиз.  

 

 
 
Айтайлик сиз фотосуратлардан биттасини айлантирмоқчисиз, бироқ бу 

ишни кейин бажармоқчисиз. Сурилувчи тугмани эсдан чиқармаслик керак 
бўлган жойга ўрнатамиз, Insert ни босамиз ва ундан кейин Marker ни босамиз. 
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У ерга бирор нарса ёзамиз ёки белги қўямиз. Энди сиз қилмоқчи бўлган 

ишингизни охиригача етказишингиз мумкин бўлади.  

ҲУДУДЛАР 
Ҳудуд бу маркерга ўхшаш бўлиб, фақат бу ҳолда битта эмас иккита 

кўрсаткич яратилади ва натижада ҳудуд ҳосил бўлади. Ихтиёрий тарзда 
бирнечта файлларни оламиз. Сичқонча билан муайян кесимни белгилаб 
оламиз.  
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Кейин Insert ни ва Region ни босамиз ва керакли изоҳли ёзувни 
яратамиз.  

 

 
 

ТРИММЕР ИНСТРУМЕНТИ 
Триммер видео ва аудио файлларни таҳрирлаш имконини беради. Бунда 

бутун файлни эмас, балки унинг бирорта участкани танлаб олиб уни 
триммердан Time line га туширамиз. Буни фақатгина катта файлни таҳрир 
қилиш лозим бўлганда амалга ошириш керак. Триммер ана шу вазифани 
осонлаштиради.  

Дастурни ишга туширамиз ва керакли файлни очамиз.  
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Файлни танлаб оламиз ва уни Time line га туширамиз. Олдинги 

дарслардаги каби биз ёзувчи головка ёрдамида видеодаги керакли лавҳани 
танлаб олиб, лавҳани қисмларга бўлиш ва керакли бўлмаганин олиб ташлаш 
учун «S» клавишасини босамиз. Бироқ бу узоқ давом этади.  
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Бу ҳолда триммердан фойдаланиш қулайдир. Файлни триммерда очиш 
учун Project media оёнасида файл устида сичқончанинг ўнг тугмасини босиб, 
контекстли менюдан Open in Trimmer ни танлаймиз. 

 

 
 
Олдиндан кўриш имконини берадиган яна битта ойна пайдо бўлади. 

Унинг ичида сиз ҳаракатланишингиз мумкин бўлади.  
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Файлдаги бизга керакли лавҳани танлаб оламиз ва курсор турган жойга 
маркер қўямиз. Кейин лавҳа тугайдиган жой танлаймиз ва шунингдек 
якунловчи маркер қўямиз. Бизда ажратиб олинган кул ранг ҳудуд ҳосил 
бўлади.  

 

 
 
Кул ранг ҳудудда икки марта сичқончани босамиз, белгилаб олиш пайдо 

бўлади ва уни Time line га олиб ўтамиз. Натижада монтаж тасмасига бутун 
файл эмас, унинг танлаб олинган лавҳаси тушади.  

 

 
 
Time line да турган кесиб олинган файл устида сичқончанинг ўнг 

тугмасини босиб, контекст менюдан Open in Trimmer ни танлаб олиш 
мумкин, ўшанда бу файл кесилган ҳолда эмас, балки бутунлай очилади.  

Бу видео жуда катта бўлган ҳолда ва олиб ташлаш керак бўлган жойлар 
кўп бўлганда жуда қулай ҳисобланади.  

Триммерда аудио лавҳалар билан ҳам ишласа бўлади.  



АУДИО- ва видеомонтаж   

     46 

 

 

 

 

 

 

 

ВИДЕОНИ СЕКИНЛАТИШ ВА ТЕЗЛАТИШ 
Файлни импорт қиламиз ва TimeLine га кўчириб оламиз. 
 

 
 
Insert → Video Envelops →Event Velocity майдонларига ўтамиз. 
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TimeLine да яшил тўғри чизиқни 150% ва бошқа вақтли ҳудудда 50% 

қилиб ўрнатамиз. 
 

 

ОВОЗ БАЛАНДЛИГИНИ ЎЗГАРТИРИШ 
Файлни импорт қиламиз ва TimeLine га туширамиз. 
 

 
 

Insert→AudioEnvelopes→Volume майдонига ўтамиз ёки Shift+V ни 
босамиз. 
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Йўлакчанинг ўртасида тасма бўлиб, уни тепага ёки пастга суриш 

мумкин бўлади, бу овозни бошқариш бўлади.  
 

 
 

Тасмаларга босамиз ва сичқончанинг чап тугмасини икки марта босиб, 
асосий нуқталарни яратамиз.  
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Дастлабки ҳолатга қайтиш мумкин, бунинг учун сичқончанинг ўнг 

тугмасини босиб Resetall ни танлаб оламиз. 
 

 

ЭКРАН СУРАТИНИ ЯРАТИШ 
Файтни импорт қиламиз ва TimeLine га туширамиз. 
 

 
 
Бизга керакли лавҳани топамиз ва S клавишасини босамиз. 
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Snapshot to File ни босамиз ва сақлаб қоламиз. 
  

 
 
Сақланган фотосуратни TimeLine га туширамиз. 
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Фототасвирни керакли вақтгача чўзамиз. 
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5-АМАЛИЁТ. Ниқоблар. Ниқобларни қўллаган ҳолда 
комбинацияланган съёмкалар эффектини яратиш  

БИР-БИРИНИ УСТИГА ЖОЙЛАШТИРИШ РЕЖИМЛАРИ 
Треклар билан ишлаганда биз фақат юқорида турган трекни кўра 

оламиз. Унинг тагидаги расмни кўриш учун биз шаффоф бўлмасликдан 
фойдаланган эдик. Турган. Бироқ бу ҳаммаси эмас, бир-бирини устига қўйиш 
режими туфайли бизда икки қатламнинг бир-бири билан ранг орқали 
мулоқот қилишига имкон берамиз. Натижа қўлланилган режимга боғлиқ 
бўлади.  

 

 
 
1. Дастурни ишга туширамиз. Файлларимизни импорт қиламиз. 
2. Бир-бирини устига жойлаштириш режимини ўзгартириш учун 

ҳаракатланиш тугмалари орасида Compaciting Mode ни топиш керак.  
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Сичқончанинг чап тугмасини босамиз. Аввалдан Course Alpha (шаффоф 
бўлмаслик) турган бўлади. Бошқа ихтиёрийсини танлаб оламиз ва нима 
бўлганини кузатамиз.  

 

НИҚОБ ВА БИР-БИРИНИ УСТИГА ЖОЙЛАШТИРИШ 
Ниқоблар jpg ёки bmp форматида бўлади. alpha канали бўлмаган жойда 

ва бир-бирини устига жойлаштиришни билмаган пайтда сиз буни қўллай 
олмайсиз.  
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Агар бизда қора рангни шаффоф қилиб қолдириш лозим бўлган ниқоб 
бўлса, Screen дем номланадиган бир-бирини устига жойлаштириш режимини 
қўллаймиз. У қора рангни очартиради ва шаффоф қилиб қўяди.  

 

 
 
5. Ниқобдаги оқ рангни шаффоф қилиш учун бир-бирини устига 

жойлаштириш режимида Multiply (Mask) ни қўллаш лозим. 
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6. Ниқобнинг ранглар мажмуасини ўзгартириш учун Video FX 
вкладкасига ўтиб Gradient Map тоифасини топамиз. Биринчи пресетни 
танлаймиз ва уни ниқобли қатламга кўчирамиз.  

 

 
 
Ҳеч нарса содир бўлмайди. Очилган ойнада шахматли ҳудуд бўлиб, 

унда «0», «1», «2» рақамлари бўлади. «0» рақами тўқ рангларга, «1» рақами 
ярим тўқ рангларга, «2» эса оч рангларга жавоб беради. Булардан битта 
рақамини босиб биз керакли ниқоб рангини танлашимиз мумкин бўлади. 
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. 

   
 
Бу бир-бирини устига жойлаштириш режимида ниқоблар билан 

ишлашнинг ягона йўли эмас. Бунга ранги тўғриловчи тоифалар ёрдамида 
(Color Correction) эиршиш мумкин, биринчи пресетни танлаймиз. Бу ерда 
рангли шкала ўрнига рангли айланалар бўлса ҳам ишлаш тамойили худди 
шундай бўлади. Айлана марказини суриб сиз рангни ўзгартиришингиз 
мумкин бўлади.  
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alpha каналли файлнинг рангини ўзгартиришингиз учун бир-бирини 
устига жойлаштириш режимини қўллашнинг ўзи етарли эмас, чунки бунда 
керак бўлмаган ортиқча нарсалар пайдо бўлади. Бундан қутулиш учун янги 
видео трек яратамиз (CTRL+SHIFT+Q) ва Media Generators вкладкасидан 
Sold Color тоифасини танлаймиз. Ихтиёрий қатламни танлаймиз ва уни 
видеотрекка кўчирамиз.  

  

 
Энди бу трекка Multiply (Mask) бир-бирини устига жойлаштириш 

режимини қўллаш керак. Барча расм яшил рангга бўялади.   
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Таъсир қилиш фақат ниқобга таъсир қилиши учун уни фарзанд қатлами 

қилиб олиш керак. Бунинг учун Make Compositing Child тугмасини босиш 
керак бўлади. 

 

  
 
Энди ниқобни кўздан кечиришда керак бўлмаган “ахлат” пайдо 

бўлмайди.  
 

  
 
Энди сиз ниқоб рангини ўзгартиришингиз мумкин, бунинг учун Media 

Generators га кириб, ана шу лойиҳага тўғри келадиган рангни танланг.  
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 «РАСМ ИЧИДА РАСМ» ЭФФЕКТИ 
Файлни импорт қилиб Time Line га туширамиз. 
 

 
 

Видео йўлакни қўшамиз ва Media Generators да титрларни танлаймиз 
сўнгра кўчириб олиб ўтамиз 
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Асосий кадрлар билан видео файлни жойлаштирамиз. 
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МАТН ИЧИДАГИ ВИДЕО  
Файлни импорт қиламиз ва Time Line га туширамиз. 
 

 
 
Видео йўлакка матн қўшамиз ва уни тўғрилаймиз. 
  

 
 

Video FX→ Lens Flare га кирамиз ва пресетлардан ихтиёрийсини 
танлаймиз, кейин тўғрилаймиз.  
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Бир-бирини устига жойлаштириш режимига кирамиз ва Multply(Mask) 

ни танлаймиз. 
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